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SESSION ONE:

Welcome to Photobook Shop.

Photobook Shop allows you to share your Photobooks, and your memories, with your friends and
family on Facebook and other social networking sites.

Memories from birthdays, holidays, and special occasions can be shared with Photobook Shop -
comment on photos, rate projects, and order duplicates for your personal collection

Share your tips and tricks with other Photobook members — Photobook Shop is a hub for
photographers to meet, whether beginner or professional. Review designs, offer photography
advice, and software tips

Photobook Shop offers a platform for professionals to share their products. Upload your
Photobooks, showcase your company, and allow potential clients to engage with your brand and
view your products.

LESSON ONE

In this section you will learn how to:

e Sign up to www.thephotobookshop.com.au

e Download Photobook Shop software

e Select and customise your personal Photobook Shop layout
e Individually name your Photobook Shop project
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Lesson 1.1: Downloading

System Requirements:

Minimum Mac Specifications:

768MB RAM
2GB free hard disc space
Windows XP (Service Pack 2 or 3) or Windows Vista

Minimum PC Specifications:

1GB RAM
2GB free hard disc space
Mac 0S 10.3.9

You will also need basic computer components, such as a monitor, mouse and keyboard.

Installing Software:

The software required to create Photo books and join Photobook Shop can be accessed at
http://www.thephotobookshop.com.au/
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Go to our website www.thephotobookshop.com.au, click on the Download button and after
entering your name and email, we will ask you to select the version you would like to
download (Mac or PC). Once you have downloaded the software, follow the prompts on-
screen and you’ll be ready to start using the software.
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Please enter your details:
First Name *

Last Name *
Email *
Password *

Where did you hear about us *  Select  [~]

Your email address will be used as your login. Please remember
these details as you will need them when you place your order.

If you already have an account then you won't be issued with a
new account your existing account will remain unchanged.

Submit now fo choose instalier

Once downloaded, the program will appear in the start-up menu.

@ Microsoft Word 2010
% Snipping Teol

W PhotobookShop.com.au
,-f.;ﬁ) Paint

\E‘i’ Getting Started

!' Connect to a Projector

O?IE Microsoft Outlook 2010

Calculator

Sticky Motes

« KPS Viewer

»  AllPrograms
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Lesson 1.2: Getting Started

Once the program has opened, you need to select New. Download a software update — click
start and install any available updates. This will download the latest sizes and templates for
you.

} | Your Selections:

to Update...

Please select the items you wish to download...

Choose Product -
Application Dats

O

Products

Autumn Photobook Collection

Calendar A4 Landscape

Christmas Photobook Collection

Classic Photobook Collection

Easter Photobook Collection

Fathers Photobook Collection

How to Create Your Book Photobook Collection

[T

Choose Pictures

Choose Options

Kid's Birthday Photobock Collection

Kids Heliday Photebook Collection

Kids Xmas Photobook Collection

Mothers Photobook Collection ad

Choose Background

SEEEEEEEEEE

Preview

\

:
Check For Updates Cancel Back Mext
ComenD

Select the format of book you would like. If you are using a voucher, be sure that the size
you select corresponds to that stated on your voucher.

Then click ‘Next’.

The next screen will ask you to select which photos you wish to use. Click the ‘add folder’
icon to add your photos. Select the photos which you choose to add. Add photos to your
project.

We recommend keeping all of your photos in one place, such as a specified folder on your
desktop.
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Clmose Pictures
»
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Choose Options o 1w g
Choose Background Chrysanthemum jpg e range: el i
Preview

A | 22 () T SO

A B3 Ape

Koala jpg Lighthouse jpg Penguins jpg Tulips jpg

Check For Updates

=
You may click to add an entire folder of images

=y
You may click to add individual images.

% . Removes a image from your selection

-

" - Rotates images clockwise or anti-clockwise

Once you have added your images click “Next”. The more images you select the more pages
the wizard will add to your book.

Note: You may wish to skip the Wizard at this step by clicking on the Skip Wizard button
bottom left of the window.

Select how you want the wizard to decide how many pages you would like.
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Blank Photobook Collection - Blank 26cm x 33cm Landscape Photobook

Please choose your options...

Use The Slider To Select The Mumber Of Pages 120

Estimated Project Price: $99.95.

Vou must add at least 40 mare pictures to fill il of the pages.

[ | (e ]

Select Number of Pages: Use the Blue Guide (click and drag) to increase or decrease the

amount of pages

Select Pictures Per Page: Use thi
page.

s option if you want to set how many images you want per

Once you have finished your selection click “Next”

Select the page background design you like. You can always change this later.

Click next once you have made your selection

b | Your Selections:

Check For Updates

Clazsic Photobooks  Blank Photobook Collection — Blank 26cm x 23cm Landscape Photobook

Please choose your background...

Page Background: [ChangeBackgrownd | =|

At

|

IIIIQ

1 MOOD BOARD MOOD

spmERT

MUSTARD 1 ROYAL 1 ROYAL 2

II.!E

HOOD BOARD
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Enter a project name. Make sure your name describes the project as you will use this to re-
open your project in future.

Click “Create”

P [YourSelections: ' Classic Photebooks . Blank Photobeok Collection - Blank 26em x 33cm Landscape Phetobook

Preview your design...

Please enter your project name:

Preview

Check For Updates

Practise Exercise

The steps above are the basic steps for opening and beginning your own project. Try the
following exercise:

Once downloaded open a 30 X30 Classic Photobook, then press next.
Add 20 Photos to your Project, then press next.

Select 40 pages, then press next.

Select a background, then press next.

Give your project the title “Practise Photobook One”

Click create.

S hwNPE
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Lesson 2: Getting to know your features

In this section you will learn:

e Learn the different functions of the toolbar.

e You will learn about Page Styles

e You will learn how to crop and image

e You will learn how to resize an image

e You will learn how to add, rearrange, delete and duplicate pages
e You will learn how to add an image to the page.

Lesson 2.1 Getting to know your toolbar

1T 2
v Vv
o

v v ] )
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1. Undo

Undo your last change.

For example; if you change the picture size and decided you prefer the previous format,
click undo and it will revert back to the previous size.

2. Redo

Redoes the last change.

For example; if you undo the picture size and then decide that the you did prefer the
change, click redo and it will reapply the change.

3. Save
Shortcut to saving the project.
This is important to ensure that your current project is always up-to-date.

4. Add Picture Box

Clicking on here places a square picture box in the centre of your left hand page.
Click on this box and drag on the corner to manually change the size and shape,
Holding down the shift key at the same time will maintain the proportions.

Click anywhere within the box and drag to move the box anywhere on your pages.
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To populate your image box select the image you wish to use from the Pictures panel on the
left, click and drag the image in to the picture box. If you then double click anywhere in the
image box you will be taken to the Crop Picture panel where you can resize the image within
the box and choose which area of the image you desire.

i

vy — —
° ML=  AN€ED» QO

5. Add Text Box

Clicking on here places a square text box in the centre of your left hand page.

As with the picture box click on this box and drag on the corner to manually change the size
and shape. If you hold down the shift key whilst doing this it will scale the image
proportionally.

Click anywhere within the box and drag to move the box anywhere on your pages.

To edit your text, double click anywhere in the text box you will be taken to the Text Editor
Menu where you can add text and change its properties.

A red border around the text box is a warning that there is too much text contained within.
To fix, either expand the size of the box by dragging on the corner or double click on the text
box to bring up the Text Editor Menu Panel again and adjust the settings.

Any font installed on your computer can be used for your text.

6. Autoflow

The Autoflow function is a great time saver if you already have all of your photographs the
right way up in the Picture Panel.

Autoflow automatically uses all of the images in the Picture Panel and flows them into the
document using the page styles provided at random. You can still go through the document

manually and make any additional layout changes and adjustments.

This can be used to save time in individually placing your own photos.

10 11
\ A

| vy Vv
s o H = O™ NeE» QO
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7.Zoom Out

Allows you to zoom out on the page.

This can help to see the page at a distance.

8. ZoomlIn

Allows you to zoom in on an area of your page.

This can be used if trying to identify small parts of a page. Also useful in ensuring photos line
up.

9. Previous Page

Navigates you to the previous page.
10. Next Page

Navigates you to the next page.

11. Preview

Enables you to view your entire book full screen.
This will show your project as it will appear printed.
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Lesson 2.2 Pane Functions

Left Pane: This shows you all the images you have selected for your project. To add more
images click on the plus * button. To add an image to the page click, drag and drop in the
position you would like the image to appear.

Top Pane: This shows you all your pages.

Bottom Pane: You have 5 tabs here. TOP PANE

R M )

AeEw O

REUR

R v || Sogoumis || Frmm || Soupivnt |

o SRR ] |
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WEOLEFADEOUT  GREVECAE Erea

LEFT
PANE

The Bottom Pane comprises of: Page styles, Background, Masks, Frames and Scrapbook. We
will discuss the others in Lesson Three.
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Page Styles:

Styles are pre-designed page layouts that use existing items found in the other tabs. To
apply a style to a page simply click, drag and drop onto the page.

\\ // \\ Y
N / N 4
NS N S
N4 N
N AN
/ N\ / N
/ S N\
vl / S
Wf Masks ” Backgrounds l f Frames l f Scrapbook l |§
cln = DB g e B zcscc
gCRISP FULL SPREAD BLOCK S;I!‘EI J GREY HALF jr rl | 18 CLI_BE_LJ |—”_|

INNER SIMPLE

FULL IMAGE

LU}

You can use this toolbar to select which page style you would prefer. Once selected, you can

still alter size and positioning.

CUBED

NORY CUBE

¢
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Resizing Images:

There are two ways that you can resize an image

1. Click on one of the corners of the image. Drag the image out.
This will allow you to resize to any size and it may crop the image

H I

2. Click on one of the corners of the image. Drag the image out. (Hold down shift
while doing this)
This will keep the image constraints so the image won’t be cropped.

When resizing the background, the green grids are there to help you with your sizing.
This will help ensure pictures are of equal size (if you want)
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Cropping Images

M-12 13-14 15-16

Double click on the image. An image crop window
will appear.

You will notice the area that is visible.

You can click and drag on the visible section of the
image to crop.

You can also click and drag the bottom right of the
image to increase the area that is cropped.

Adding Additional Images to Pages:
There are two ways you can do this.

1. Dragand drop images from the Left Pane onto the page.

2. Add a Picture Box (Top menu, Insert > Picture Box > (select Shape)

Resize your picture box, then drag and drop your image onto the picture box

WP Project "My 30th Birthday' (Classic Small 21cm x 21em Phobubo;l_
File Edit Insert Page View Help

Pictur-3 1l

V4

-

Chrysanthemum.jpg = _I_O - ,E ‘é ﬁ L‘Eﬂ ‘ 3\ f:\ @ % @

Desert.jpg

1

-y

Hydrangeas.jpg
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Add/duplicate/rearrange pages

From the top menu select Page then Insert, From here you can also duplicate, delete
and rearrange pages.

Project "My 30th Birthday' (Classic Small 21em x 21cm Photobook
\ File Edit Insert | Page | View Help
Pictur ,

Insert Ctrl+I

Duplicate |
Add Ctrl+Shift+1 !
Delete Ctrl+D -

Rearrange Pages...

First Ctrl+F [~
Chrysanthemum.jpg Last Ctrl+L
Previous Ctrl+B I~
Mext Ctrl+M
If [
SESSION ONE REVIEW

Allow students 30mins to use their own photos and begin their own book (which will later
be printed)

- Select photos for your Project
- Choose a layout for your book
- Choose where you would like your photos to be
- Choose picture sizes and cropping
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SESSION TWO

Lesson 3: Individualising your Project

In this section you will learn how to:

Use the bottom panel.

Use Masks on your images.

Create different backgrounds.

Use frames with your pictures.

Use the scrapbook function to add to your photopage
You will learn the functions of the right pane
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3.1 Further Use of the bottom Panel
Masks: Masks sit on top of images to create an effect over them. To apply a mask on an

image simply click, drag and drop onto the image.

Example: The picture below shows how different masks can change the appearance of a

picture.
Page Styles ” Masks ” Backgrounds ][ Frames ][ Scrapbook ]
P “} = -% .
2 -
o,
Mo
mask § mask 9 page edges square blurry arunge leaves_square mask & pawprnt scraggy edge

You can use this toolbar to select which mask you would like to use on your photos.
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Backgrounds: To apply a background to a page simply click, drag and drop onto the page.

Example:

Page Styles ] [ Masks ] P Backgrounds { [ Frames ] [ Scrapbook
1 h
W 2 &%
P L\:' .:;\u & 5 . . doa r 1-".
cosmic_party drinks sweets_burst sweets_outline Spotlight_plain Spotlight_subtl Spotlight_top bright sky clearing Fur_giraffe
1 [ ] ] 3

~

You can click on the backgrounds here to change your pages background.
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Frames: Frames sit on top of the image and do much the same as a real frame. To apply a
frame to an image simply click, drag and drop onto the image.

Example

[ Page Styles ][ Masks ][ Backgrounds ]F Frames ” Scrapbook ] Bt~

i | ] ] ] 1 ]0O

- - | inner 2 outer 2 —
None Antigue Circle driftwood stamp_circle inner 1 outer 1 Polaroids. Untitied-1

< Y [ | C

/ You can use this tool bar to select a frame to frame your picture.




PhotohooksHorP

www.thephotobookshop.com.au
Page |20

Scrapbook: Scrapbooks are like clip art. You can add images to your scrapbook and then
apply these to other pages.

Example:

b

[ Page Styles ” Masks ][ Backgrounds ][ Frames ” Scrapbook '
S gem F orange F pink F white pin g bone

E] [ 1] |

Choose from this toolbar to select which add on you would like. You can add as many as you
like of each.
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You can add your own by clicking on the button and add, then navigating to your desired
scrapbook item on your computer.

Practise Exercise:

Insert a page style different to the current page style.
Add two different masks to two different photos.
Apply a different background to three different pages.
Apply a frame to each of your photos.

BWNRE
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Right Pane: The right pane has your properties and settings

Tab 1: ‘

Here you can control the image properties.

Examples are as follows

Change the shape of the image box
Add Corners
Change Opacity
Add Boards
Add Shadows

Not only can you change the number of sides of an object but you can
also change the angle, the corners can be curved as dramatically as you
choose, borders can be added in any colour with any opacity at a
variety of thicknesses and text boxes can be made any colour from the
dropdown menus shown.

Whether your item is a Text Box or a Picture Box, a Drop Shadow can
easily be added, giving life to your book and lifting your images from
the page. In this panel, you have full control of how you would like the
shadow to appear by adjusting the Offset, Angle, Blur, Colour, the
Expanse and the Opacity.
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Tab 2:

More image options appear under here

Change the angle of images

Change Colour Mode from Colour to Black and White to Sepia.

Add Vignette (A device used to print photographs and illustrations with
borders that fade gradually into the background.)

All of the functions apply to the actual box that the image is in and not to the image itself.
So, if you replace the image in the box the new image, it will be affected in the same way as
the previous image, for example, changing its Angle, Flipping it, changing its Colour more to
Sepia or Black and White or applying a Vignette.

Tab 3:

This has settings for text boxes
Tab e 4

Rule and Position Settings for the item you have selected on your page

In the Position section you set the exact X and Y coordinates of your item.

In Size you can set the size. Click the Constrain Proportions check box to keep proportions
the same.

Offset refers to how the image is placed within the image box. When an image is cropped,
panned or zoomed these settings are set automatically to the centre of the image. The
Offset tool here allows you to set this manually. You can also affect this by holding down the
Alt key, clicking and moving the image or in the Crop Picture window that is produced by
double-clicking on the image.

Scaling the % of the image controls the magnification of the image within the box. As with
Offsetting you can set this manually, in the Crop Picture window that is produced by double-
clicking on the image or by holding down the Control and Alt keys whilst dragging the image
within its box. You have complete control over the rotation of images on the page by
dragging the dial control or manually inputting figures in to the field on the right of the
Angle setting section.
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Tab5: [
Page Background Colours- here you can select the left and right page colours separately.

Practise Exercise:

1. Change one picture to sepia and one picture to black and white
2. Change the opacity of two images
3. Add a text box and write a comment about the chosen photo

You are now ready to customise your Photo book in any way you like.



PhotohooksHorP

www.thephotobookshop.com.au
Page |25

Lesson Four: Finishing and Ordering
In this lesson you will learn how to:

e Check and proof your photo book
o Upload your Photobook for printing.

Now that you have finished your project there are two last things you need to know:

4.1 Proofing

When you are satisfied that you have completed your book you may choose to check your
project through.

First you are required to save the project then in the File menu select Check Project, this will
bring up a pop-up window where it may give any warnings of missing images, over flowing
text, or pictures that are low quality. You can then preview the document by pressing the
preview button.

Project tet A BT [CRESETOR
File | Edit Insert Page VWiew Hel
Save Ctrl+5
Close Ctrl+W
Check Project...
|
) Order...
Preferences...
Excit

Once you are totally satisfied with the product you can then proceed to the checkout to
complete your order.
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4.2 Ordering

To order, either select File - Order from the main menu, or select the green checkout button

If you did not already check for any issues with the file, Photobook Shop will automatically

on the top right hand corner.

proceed to this step for you.

A results window will inform you of any problems. If a yellow warning triangle is displayed,
this is simply a warning and you may proceed with the order if you choose to. However, if a
red symbol is shown you will be required to fix the problem in order to complete your order.
Once satisfied, you can click OK to proceed.

Photobook Shop uses an encryption system to create the high resolution files of your
project. The files you have either uploaded or saved to a disc are encrypted and are
exclusive to Photobook Shop and your license of the software. They can only be decrypted
by Photobook Shop.

A disclaimer box will then appear where you need to read the agreement and click OK to
proceed. If you have any issues please don’t hesitate to contact us.
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The Photobook Club is not liable to you for any loss you suffer in connection with your access or use of this Site, any linked
websites or any software available at the Site. To the fullest extent permitted by applicable law, The Photobook Club DISCLAIM ALL
IMPLIED OR EXPRESSED WARRANTIES OR CONDITIONS, HON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE, INCLUDING ANY IMPLIED WARRANTY OF TITLE, regardless of whether we know or had reason to know of your particular
needs. No employee, agent, dealer or distributor of ours is authorized to modify or make any addition to this limited warranty.
IN NO EVENT SHALL THE PHOTOBOOK CLUB BE LIABLE FOR ANY DIRECT OR INDIRECT DAMAGES, INCLUDING, BUT NOT LIMITED TO,
DAMAGES FOR LOSS OF PROFITS, DATA OR OTHER INTANGIBLES; OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES EVEN IF
THE PHOTOBOOK CLUB HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, ARISING FROM THE USE OR THE INABILITY TO
USE THE PHOTOBOOK CLUB'S SITE, MATERIAL, IMAGES OR SERVICES. FURTHERMORE, YOU ACKNOWLEDGE THAT THE PHOTOEQOK
CLUB IS NOT LIABLE FOR THE DEFAMATORY, OFFENSIVE OR ILLEGAL CONDUCT OF ANY OTHER PARTIES AND THAT THE RISK OF
INJURY FROM THE FOREGOING REST ENTIRELY WITH ¥OU. SOME JURISDICTIONS DO NOT ALLOW THE LIMITATION OR EXCLUSION OF
INCIDENTAL, CONSEQUENTIAL OR OTHER TYPES OF DAMAGES; THEREFORE, SOME OF THE ABOVE LIMITATIONS MAY NOT APPLY TO
u.

As our customer, you agree to fully indemnify The Photobook Club, and all our Staffs and Agents from and against all damages,
losses, expenses and costs, induding ‘ fees, ing from any violation of these Terms of Service, or any
circumstances related to your negligence or wrongful conduct when using this Service.

For full terms and conditions please visit our website www.thephotobookclub.com.au.

[T]1have read the disclaimer and accept the terms and conditions
Please read and agree to the terms of our disclaimer,

Accepting the disclaimer and clicking the Start button will connect you to our online order form. You must be
connected to the Internet to complete your order.

Click Start to begin the order, this will automatically open up a new web-browser window

displaying the login for the Photobook Shop online ordering system.

Since you are a new customer you will have to click the New Customer link on the page, if

you are an existing customer who has previously signed up you, will be able to re-use the

same login and password.

ogin

Existing Members Please Login To Continue

Login: %*

Password: *

Forgotten your Password?

You will then be required to add your personal information including your billing address.
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You must complete all the necessary fields in this section before proceeding. Clicking
‘Create’ will finalise creating your account with us.

When you continue to the Order Details section you can request the amount of products
you wish to order, as well as any other specifications you require for your product. You must
remember at this stage to click on ‘Click to update the item total’.

Your order has been accepted and has been given the order number 23201588.
Please close this window and return to the application to complete the ordering process.

An order confirmation email will be sent to you shortly.

You will then be required to complete the ordering process.

Order...

Upload Order Speed Test Send Order Via Mail

0 Please choose your preferred method of sending your order from the options above.

Cancel Continue
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The Upload process will then begin. This may take some time, once complete Photobook

Shop will have received your order.

i Upload Order... 1
Cover...
= |
Item6 Of6..
————  C—— |
"y

All that’s left now is for you to receive your beautiful creations.
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TROUBLESHOOTING
Vouchers
Occasionally there are issues with your voucher. Here are the main ways to remedy this.

e Check that the book you have made corresponds to what is on your voucher.

e Ensure you are entering the voucher code as stated on your voucher.

e Check the expiry date.

e Email us on smile@thephotobookshop.com.au with a full screenshot of the error

page, and your voucher as an attachment. This will allow us to diagnose the
problem, and fix it for you as soon as possible.

Issues connecting to server

1. Do you have antivirus? What type? If your running Norton 360 you will need to disable
this to download and install our software.

2. Do you have a firewall? What type? If your firewall is blocking FTP port 21 then you will
have troubles accessing our updates and our uploading server.

3. Are you on a corporate network? If so your work may be blocking FTP port 21 then you
will have troubles accessing our updates and our uploading server.

4. What type of internet connection do you have?

You may have to use another internet connection or computer. If so it’s easy to move your
project.

You need to:
1. Install our software

2. Copy the ‘ThePhotobookShop.com.au Projects' folder from My Documents to the new
computer.

3. Copy your images to the new computer

When you open the project again it may prompt you to find the missing images. It may be a
good idea to save these under the My Pictures folder.
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Save your project and send it to us.

It’s possible that you may not want to upload your project to our website, and would rather
post it. This occasionally happens when there is an issue with your internet connection.

To save your project to disc after you have already ordered.

Open our software

Open your project

Click File > Order

Select Save Finished Pages

Select My Documents as the save location.

Now that you have saved your project you may burn it to CD and post it to
Attn: Uploads

239 Separation Street, Northcote, Victoria 3070
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This Photobook Shop User Guide has been specially written for you to help you
throughout the creation of your photo book.

If you have any feedback for us or require any additional information please contact
us at:

Photobook Shop, 239 Separation Street, Northcote Victoria 3070

E smile@thephotobookshop.com.au




